
RUPEE MASTERNODE SETUP 
GUIDE 

 

Hi, and welcome to you. I have found Masternode ownership to be a very 
rewarding, and along the way teaching me about Ubuntu and Windows as 
well as making me extra money for coins that would just be sitting in my 
wallet anyway! In this guide we will cover a Windows set up and an Ubuntu 
set up. 

BEFORE YOU BEGIN, YOU WILL NEED: 

 20,000 RUP 

 The latest Rupee wallet, which is found 

here: https://github.com/rupeedigitalassets/Rupee-Core/releases 

 A Windows programs (PuTTY: http://www.putty.org/ Installation 

Package for Ubuntu) 

 A VULTR account, which can be found here: https://www.vultr.com/ 

 An ability to follow instructions to the letter 

 

I will be your guide through this understandably intimidating set-up. It is 
easy just please take it slow, and be sure to thoroughly follow the 
instructions. 
 
You will be setting up a Masternode on a remote server, and keeping your 
Rupee on a local Windows PC. Your Rupee are never in danger from the 
remote server, and I will show you how to run this Masternode with your 
wallet offline/cold so your Rupee will not be in danger on your Windows PC 
either. Please ensure your antivirus is up to do date and backup your wallet 
regularly. I will show you how to do this. 
 
Right let’s get to it! If you have any questions or comments please join our 
telegram group and we will be more than happy to help. 
(https://t.me/rupeeblockchain) 
 
LET'S GET STARTED! 

https://github.com/rupeedigitalassets/Rupee-Core/releases
http://www.putty.org/
https://www.vultr.com/
https://t.me/rupeeblockchain


First we will guide you how to set up on an Ubuntu server. 
 

UBUNTU VPS SET-UP 
 
First, you will need to prepare the Windows PC and the Rupee Wallet 
(Rupee-qt.exe) to support the Masternode setup. 

Please bear in mind the following safety tips: 

 Always do a backup of your WALLET.DAT if you have Rupee on 

your computer. 

 Think twice before deleting or overwriting anything, as there is no way 

back. 

 Never copy WALLET.DAT when your wallet is running! Please use 

the BACKUP WALLET command from within your wallet instead. 

 

This guide is going to assume that you have a clean PC with no Rupee wallet 
installed. If you have installed a Rupee wallet already, you are ahead of the 
game! You get to skip the next line, only: 
 
Download the latest Windows version of "Rupee-qt.exe" (the Rupee wallet) 
as found on this page: https://github.com/rupeedigitalassets/Rupee-

Core/releases 

 

Copy the "Rupee-qt.exe" file to your desktop. 
 
Start up your new Rupee wallet. You may get a security pop up from your 
virus scanner, this is a false positive and you will need to disable your 
antivirus and add the Rupee-qt.exe to the exceptions list. Please search on 
Google how to do this for your antivirus. 
 
Now please wait for your wallet to fully sync with the network. 
 
It should look like this, "out of sync" until it is fully caught up with the 
network. 
 

https://github.com/rupeedigitalassets/Rupee-Core/releases
https://github.com/rupeedigitalassets/Rupee-Core/releases


 
 

Now the wallet has finished syncing with the network! You are now ready 
for the next step: 
 
On your Desktop, create a new notepad file. 
 
Back in your wallet, click on HELP, then DEBUG WINDOW. 
 

 



 
 

You will find the command line at the bottom of the console. 
 
Enter the following command: "masternode genkey" and press ENTER. 
 
You will see a long string of numbers and letters. 
 

 
 



Please copy/paste this string to the new notepad file on your Desktop. This 
is the key you will need to verify your Masternode later in the process. 
 
Enter the following command: "getaccountaddress 0" and press ENTER. 
 
This will generate your new Masternode's receiving address! 
 
Please copy/paste this string to the notepad file, as well. 
 
Please note: This address will be the one that you will send your 20,000RUP 
to. 
 

 
 

Once you have copy/pasted these items into your notepad file, you are 
finished with the Console. You may now close it, and return to the Overview 
screen. If you have multiple masternodes please repeat the steps for 
Masternode genkey and get account address and label them in your 
notepad. 
 
Important safety procedure time! 
 
Begin securing your wallet by clicking on SETTINGS, ENCRYPT WALLET. 
 



Enter a password, repeat it, and click OK. Do not forget your password! Keep 
it somewhere safe. 
 
IMPORTANT: I recommend that you type your password into your notepad 
file, and then cut/paste into the password field so you are sure of what your 
password will be. This is a big investment, and it pays to be sure! 
 
Before sending any coins to you new wallet, please ensure that you are able 
to unlock the wallet first. 
 
You will see your Rupee wallet may become unresponsive for several 
seconds, this is normal. Please do not hit any keys until your wallet has 
finished encrypting. Once your wallet has finished and closed, you are ready 
for the next security step: 
 
Re-run your wallet (Rupee-qt.exe) and immediately go to FILE, BACKUP 
WALLET. 
 

 
 

Select the location where you want to store a copy of your WALLET.DAT, 
and backup your wallet. 
 
Please note: I recommend backing up your wallet to several USBs to keep in 
different locations. 



I can't stress this enough: BACKUP regularly! 
 
Financing your Masternode (depositing 20,000RUP to your "0" address): 
 
Please check your wallet Overview screen. If you see that the big button 
under PrivateSend says "Stop PrivateSend Mixing", please click on it to 
disable PrivateSend. If you see that the button says "Start PrivateSend 
Mixing", you are good to go to the next step: 
 
From wherever you currently hold your 20,000RUP (exchange, another 
Rupee wallet, even a different address in the same wallet), please send your 
Rupee to your new "0" Masternode receiving address in your wallet. Make 
sure the "PrivateSend" checkbox is unchecked. 
IMPORTANT: You must send EXACTLY 20,000RUP to this address, no more, 
no less, to be eligible to run a Masternode! 
 
Once you have initiated the transaction, you must wait for 15 confirmations 
so your address is eligible to be associated with your new Masternode. 
 
Ok so that is the wallet part done for your Ubuntu Masternode!  
 
Right next steps! 
 
Firstly you will need a VPS. I ordered one from https://www.vultr.com. They 
do hosting for 5$ a month. 
 
After you sign up you need to deposit 10$ from Paypal, Alipay, Debit card, 
or BTC. 
 
Than you select location of your server (EU, USA, ASIA...). 
 

https://www.vultr.com/?ref=7355262


 
 

Now select the Ubuntu server version 14.04 x64bit. 
 

 
 

Here you can select the server size. They offer also a 2$, but it's sold out 
most of the time. If it's free you should order that one, to save money. Than 
you should give your server a name, for example Masternode1. This will be 
also your Alias. 
 

 



Now we need access to VPS, the best way is to use Putty 
client: https://www.chiark.greenend.org.uk/~sgtatham/putty/latest.html 
Install and run Putty. In Host name (or IP address) we type your IP address 
from Vultur webpage. 
 

 
 

Then a pop up window opens and we click yes.  
 

https://www.chiark.greenend.org.uk/~sgtatham/putty/latest.html


 
 

Now a black screen opens and we type username. Username is always: root 
 

 



Then we copy password, which is located on VPS webpage. (Use CTRL+C) 
and click on Putty and there you just press the right mouse button and press 
enter (this is the same as CTRL+P) and we are in. 
 

 
 

After we logged in we will need to type a series of commands to get started: 
Start to keep your repository up to date before you begin, please ensure 
you follow this in order: 
 
Run the commands to update the Ubuntu server 
sudo apt-get update 
 
apt-get upgrade 
 
Run these commands to make a swap file (for a small VPS): 
 



sudo dd if=/dev/zero of=/var/swap.img bs=1024k count=1000 
 

sudo mkswap /var/swap.img 
 

sudo swapon /var/swap.img 

 
Enter the following to see if the Swap is present 
 
Free 
 

To make the swap file persist when the server is rebooted: 
 
sudo chmod 0600 /var/swap.img 
 

sudo chown root:root /var/swap.img 
 

sudo nano /etc/fstab 
 
 

Append the following line to the end of the file: 
 
/var/swap.img none swap sw 0 0 
 

Save the file and exit by pressting Ctrl + X and then press Y and enter. 
 
Compiling the wallet: 
 
sudo apt-get install git 
 

git clone https://github.com/rupeedigitalassets/Rupee-Core.git 

 

You will now need to install dependencies: (copy as one long command) 
 
sudo apt-get -y update && sudo apt-get -y install build-essential libssl-dev 

libdb++-dev libboost-all-dev libcrypto++-dev libqrencode-dev libminiupnpc-dev 
libgmp-dev libgmp3-dev autoconf autogen automake libtool 
 

Now you will now need to enter the Rupee folder: 
 
cd Rupee-Core/src 
 

Compile with the below command: 
 
sudo make -f makefile.unix 

 

https://github.com/rupeedigitalassets/Rupee-Core.git


This step will take some time to complete so please be patient. 
 
When the process is finished we need to check that the Rupeed file is 
present or not, you can do this by entering the following command: 
 
Ls 
 
The output of Ls should be similar to the below picture, and there should be 
a folder called Rupeed. If Rupeed is present we can move on to the next 
step. 
 

 
 
We now need to run the wallet to generate a rupee.conf file. An error will 
be presented here so do not worry: 
 
./Rupeed –daemon 
 

Now you need to configure your wallet, first we need to close the wallet and 
edit the rupee.conf file: 
 
./Rupeed stop 
 

cd ~/.RupeeCore 
 

nano ~/.RupeeCore/Rupee.conf 

 

With Nano add the following lines in green: (The above command opens up 
an editor) 
 
rpcuser=any_random_user_name 

rpcpassword=any_random_password 

rpcallowip=127.0.0.1 

listen=1 

server=1 

daemon=1 

logtimestamps=1 



maxconnections=64 

masternode=1 

externalip=your_server_IP 

bind=your_server_IP 

masternodeaddr= your_server_IP 

masternodeprivkey=XXXXXXXXXXX (This will be in your notepad file I asked you to 

created earlier) 

 

Save and exit by pressing Ctrl + x followed by Y and enter. 
 
Go back to your Rupeed folder by typing the following: 
 
cd  ~/Rupee-Core/src 
 
Start the Rupeed server by typing the command below: 
 
./Rupeed 
 

You can use other commands to check the status of the server once it is 
running: 
 
./Rupeed help 
 

./Rupeed getinfo 
 

Your Ubuntu VPS side is now complete and we can exit PuTTy. 
 
By this time you will/may have had 15 confirmations on your Rupee 
transaction that you sent to yourself earlier. To check this we need to go to 
HELP, DEBUG WINDOW AND THEN CONSOLE. 
 
Type the following command: 
 
Masternode Outputs 
 



 
 
You will get only empty {} if your transaction did not work properly. If you 
have a valid transaction you will get something like this: 

{ "9876235987jkghfkjashogfre987634259876342oiuyfihg98762135" : "0" } 

This is your "VALID TRANSACTION HASH" followed by your "TRANSACTION 
INDEX" 

Copy-paste the long string in your notepad (without all the extra characters 
{ : ") that is your Tx Hash. Then copy-paste to your notepad the alone 
number (0 or 1), that is called the Index. In the above case the index is 0, 
your index can be 0 or 1. 

Tx hash 9876235987jkghfkjashogfre987634259876342oiuyfihg98762135 

Transaction Index 0 
 
We are now ready to create the Masternode: 

Go to the local wallet, Masternode tab, click create. 

 

Fill in the fields: 

Alias is any random name you can choose 

Address is IP and port  ( IP:PORT) 



Private key is your Masternode private key 

Txhash is Transaction hash 

Output Index is Transaction Index 

 

 

Click ok, 

Close the wallet by going to File -> Exit. 

It should have created a file in your %appdata% roaming folder-RupeeCore 
called masternode.conf 

You can open it to check (Optional) 

In there you should have just one long string with your entire info one after 
the other: 

Alias Address:Port PrivKey TxHash Index RewardAdress % 

Now you know where to find it. 

Open the Rupee Wallet again by running Rupee-qt.exe. 

 

 



Activate the masternodes: 
*if your wallet is locked, unlock it (make sure it is fully unlocked, not only for 
Staking ). 
Now you need to active the masternode, go to your local wallet, and go to 
masternode tab,  Click on update, and click on start, if you did everything 
right, you should see a successful prompt. 
 
If you get an error that says unable to allocate Vin please check that the 
wallet is unlocked and that your transactions are not locked. You can do this 
by clicking: SETTINGS, OPTIONS, DISPLAY and then make sure the Display 
coin control features box is ticked. 
 

 
 
Then you need to go the Send tab in your wallet and click Inputs 
 



 
 
Once you have done this you need to click list mode and if there is a padlock 
you right click and unlock unspent. Once you have done this unlock the 
wallet again and click on the masternode tab and click Start all. 
 

 
 



That is it you have now successfully created you Ubuntu VPS masternode. 
You can check status to see if your masternode is online here: 
http://159.89.42.151/masternode 
 

Ok so now that is completed I will show you how to create a Windows VPS 
masternode. 

 

 

 
 

 
 
 
 

 
 

 
 
 

 
 
 
 
 
 
 

 
 
 
 

 

 
 
 
 

 

 

http://159.89.42.151/masternode


WINDOWS VPS SET-UP 

First, you will need to prepare the Windows PC and the Rupee Wallet 
(Rupee-qt.exe) to support the Masternode setup. 

Please bear in mind the following safety tips: 

 Always do a backup of your WALLET.DAT if you have Rupee on 

your computer. 

 Think twice before deleting or overwriting anything, as there is no way 

back. 

 Never copy WALLET.DAT when your wallet is running! Please use 

the BACKUP WALLET command from within your wallet instead. 

 

This guide is going to assume that you have a clean PC with no Rupee wallet 
installed. If you have installed a Rupee wallet already, you are ahead of the 
game! You get to skip the next line, only: 
 
Download the latest Windows version of "Rupee-qt.exe" (the Rupee wallet) 
as found on this page: https://github.com/rupeedigitalassets/Rupee-

Core/releases 

 

Copy the "Rupee-qt.exe" file to your desktop. 
 
Start up your new Rupee wallet. You may get a security pop up from your 
virus scanner, this is a false positive and you will need to disable your 
antivirus and add the Rupee-qt.exe to the exceptions list. Please search on 
Google how to do this for your antivirus. 
 
Now please wait for your wallet to fully sync with the network. 
 
It should look like this, "out of sync" until it is fully caught up with the 
network. 
 

https://github.com/rupeedigitalassets/Rupee-Core/releases
https://github.com/rupeedigitalassets/Rupee-Core/releases


 
 

Now the wallet has finished syncing with the network! You are now ready 
for the next step: 
 
On your Desktop, create a new notepad file. 
 
Back in your wallet, click on HELP, then DEBUG WINDOW. 
Enter the following command: "getaccountaddress 0" and press ENTER. 
 
This will generate your new Masternode's receiving address! 
 
Please copy/paste this string to the notepad file, as well. 
 
Please note: This address will be the one that you will send your 20,000RUP 
to. 
 



 
 

Once you have copy/pasted these items into your notepad file, you are 
finished with the Console. You may now close it, and return to the Overview 
screen. If you have multiple masternodes please repeat the steps for get 
account address and label them in your notepad. 
 
Important safety procedure time! 
 
Begin securing your wallet by clicking on SETTINGS, ENCRYPT WALLET. 
 
Enter a password, repeat it, and click OK. Do not forget your password! Keep 
it somewhere safe. 
 
IMPORTANT: I recommend that you type your password into your notepad 
file, and then cut/paste into the password field so you are sure of what your 
password will be. This is a big investment, and it pays to be sure! 
 
Before sending any coins to you new wallet, please ensure that you are able 
to unlock the wallet first. 
 
You will see your Rupee wallet may become unresponsive for several 
seconds, this is normal. Please do not hit any keys until your wallet has 



finished encrypting. Once your wallet has finished and closed, you are ready 
for the next security step: 
 
Re-run your wallet (Rupee-qt.exe) and immediately go to FILE, BACKUP 
WALLET. 
 

 
 

Select the location where you want to store a copy of your WALLET.DAT, 
and backup your wallet. 
 
Please note: I recommend backing up your wallet to several USBs to keep in 
different locations. 
I can't stress this enough: BACKUP regularly! 
 
Financing your Masternode (depositing 20,000RUP to your "0" address): 
 
Please check your wallet Overview screen. If you see that the big button 
under PrivateSend says "Stop PrivateSend Mixing", please click on it to 
disable PrivateSend. If you see that the button says "Start PrivateSend 
Mixing", you are good to go to the next step: 
 
From wherever you currently hold your 20,000RUP (exchange, another 
Rupee wallet, even a different address in the same wallet), please send your 
Rupee to your new "0" Masternode receiving address in your wallet. Make 



sure the "PrivateSend" checkbox is unchecked. 
IMPORTANT: You must send EXACTLY 20,000RUP to this address, no more, 
no less, to be eligible to run a Masternode! 
 
Once you have initiated the transaction, you must wait for 15 confirmations 
so your address is eligible to be associated with your new Masternode. 
 

Ok so that is the wallet part done for your Ubuntu Masternode! 

Firstly go to Vultr and get an account 

Click on the + to “Deploy New Server” 

 

Choose your “Server Location”, choosing the closest place to you, this should 

minimize ping times. 

https://www.vultr.com/?ref=7333351


 

Choose “Server Type”, choose “Windows 2012 x64 

 

Choose “Server Size”, usually the most basic size will do, choose “20 GB 

SSD/1 CPU/512MB Memory/500GB Bandwidth” 



 

On “Server Hostname & Label”, put the name you want for your VPS. 

Then click on “Deploy Now” 

 

Wait until the “Status” of your VPS says “Running”, and then click on “View 

Console”. 



 

Wait until the “Status” of your VPS says “Running”, then click on “View Console”. 

You will get a screen as below, click on “Send CtrlAltDel”. 

 

Click on the icon of “Ease of access”, then choose “On Screen-Keyboard. This 

will save you hours of frustration, facilitates typing the correct characters in 

the password. 



 

Click on the icon of “Ease of access”, then choose “On Screen-Keyboard. 

Go back to vultr.com, click on “Server Details”. 

 

Click on “Show Password”. 

https://www.vultr.com/?ref=7333351


 

Use password from the last step to access your VPS. Use On-Screen 

Keyboard so you don’t waste time typing incorrect characters. 

 

On your server manager you will need to make sure IE Enhanced Security 

configuration is switched off 



 

Once this is done you will need to click on next to Windows firewall where is 

says Public:On 

 

You then need to click Advanced settings 



 

Then you need to click on Inbound Rules and right click and click new 

inbound rule 

 

Select Port 



 

The next step you will need to come back to as we need to open the 

following ports 

TCP - 8517 

UDP – 8517 

TCP -8518 

UDP - 8518 

 



Click next and allow the connection 

 

 

 

Click next again 

 

And then finally you need to name the rule you have just created. I 

personally chose Masternode 8517udp and so on with the ports. 



 

 

So that is all of you ports open for you Masternode we can now move on to 

the next step. 

Open up internet explorer and go to 

https://github.com/rupeedigitalassets/Rupee-Core/releases to download 

the wallet. 

Copy the Rupee-QT.exe to your desktop but if you are planning on running 

multiple Masternodes of one VPS do not run it yet. If you are running one 

please skip the next parts until we open the Rupee wallet. 

Create a new folder on your desktop called MN1. Open the folder and copy 

the Rupee-Qt.exe to that folder. Inside that folder create a new folder call 

Rupeecore. 

https://github.com/rupeedigitalassets/Rupee-Core/releases


 

 

Right click on the Rupee-Qt.exe and send to desktop (create Shortcut) 

On the desktop shortcut right click and rename this to MN1. 

Right click and click properties 



 

The target needs to be as follows: 

C:\Users\Administrator\Desktop\mn1\Rupee-qt.exe -

datadir=C:\Users\Administrator\Desktop\mn1\Rupeecore -listen=0 

 

Start in needs to be: 

C:\Users\Administrator\Desktop\mn1 

For multiple Masternodes repeat this process for each Masternode you need 

to set up. 

Right now that’s all that set up the Rupee-qt.exe can we opened! 

On the wallet click on “Tools” -> “Debug Console”. 



Enter the command: masternode genkey and copy the output on a Notepad. 

Now we need to go back to the desktop where you coins are stored. 

 
By this time you will/may have had 15 confirmations on your Rupee 
transaction that you sent to yourself earlier. To check this we need to go to 
HELP, DEBUG WINDOW AND THEN CONSOLE. 
 
Type the following command: 
 
Masternode Outputs 
 

 
 
You will get only empty {} if your transaction did not work properly. If you 
have a valid transaction you will get something like this: 

{ "9876235987jkghfkjashogfre987634259876342oiuyfihg98762135" : "0" } 

This is your "VALID TRANSACTION HASH" followed by your "TRANSACTION 
INDEX" 

Copy-paste the long string in your notepad (without all the extra characters 
{ : ") that is your Tx Hash. Then copy-paste to your notepad the alone 
number (0 or 1), that is called the Index. In the above case the index is 0, 
your index can be 0 or 1. 



Tx hash 9876235987jkghfkjashogfre987634259876342oiuyfihg98762135 

Transaction Index 0 
 

Ok now we need to go back to the Windows VPS console. 

Go to your Rupee system folder or you MN1 folder if you are running 

multiple masternodes and edit the “Rupee.conf” file with your masternode 

information. Easiest way to find the this file it to go to the wallet of your 

coin, go to “Tools”, you will have either “Open Wallet Configuration File”, or 

“Show Automatic Backups”, if “Open Wallet Configuration File” exists, click 

on it, if it does not exist, click on “Show Automatic Backups”. 

Now you need to enter the following information: 

rpcuser=anyrandomusername 

rpcpassword=andlongpassword 

rpcallowip=127.0.0.1 

listen=1 

server=1 

daemon=1 

logtimestamps=1 

maxconnections=256 

masternode=1 

externalip=#IP of the VPS 

bind=#IP of the VPS 

masternodeaddr=#IP of the VPS with Port :8517 

masternodeprivkey=#Masternode Genkey from earlier 



Click save and exit and restart the Rupee-QT wallet. Please let the block sync 

and leave the wallet opn and close the VPS console. 

That is now the VPS side complete. 

We are now ready to create the Masternode: 

Go to the local wallet, Masternode tab, click create. 

 

Fill in the fields: 

Alias is any random name you can choose 

Address is IP and port  ( IP:8517) – Windows will only work with port 8517 

Private key is your Masternode private key 

Txhash is Transaction hash 

Output Index is Transaction Index 

 

 

Click ok, 

Close the wallet by going to File -> Exit. 



It should have created a file in your %appdata% roaming folder-RupeeCore 
called masternode.conf 

You can open it to check (Optional) 

In there you should have just one long string with your entire info one after 
the other: 

Alias Address:Port PrivKey TxHash Index RewardAdress % 

Now you know where to find it. 

Open the Rupee Wallet again by running Rupee-qt.exe. 

 

 

Activate the masternodes: 
*if your wallet is locked, unlock it (make sure it is fully unlocked, not only for 
Staking ). 
Now you need to active the masternode, go to your local wallet, and go to 
masternode tab,  Click on update, and click on start, if you did everything 
right, you should see a successful prompt. 
 
If you get an error that says unable to allocate Vin please check that the 
wallet is unlocked and that your transactions are not locked. You can do this 
by clicking: SETTINGS, OPTIONS, DISPLAY and then make sure the Display 
coin control features box is ticked. 
 



 
 
Then you need to go the Send tab in your wallet and click Inputs 
 

 
 
Once you have done this you need to click list mode and if there is a padlock 
you right click and unlock unspent. Once you have done this unlock the 
wallet again and click on the masternode tab and click Start all. 
 



 
 
That is it you have now successfully created you Ubuntu VPS masternode. 
You can check status to see if your masternode is online here: 
http://159.89.42.151/masternode 
 

Ok so now that is completed I will show you how to create a Windows VPS 
masternode. 

If you are running multiple masternodes please repeat the steps for each 
masternode. 

 

I hope you have found this guide helpful! Please pop over to the telegram 
channel and let us know if you found this usefull. 

 

Thanks again and happy masternoding! 

Rupee Team. 

 

http://159.89.42.151/masternode

